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Chapter 1 Device Introduction 
Thanks for purchasing AVerMedia’s product. The table below lists an overview of the 
product you purchased. From this table, you can quickly learn about your product features 
and know which chapter you need to read. Please do read this table before using AVerTV 
6 application. 

 

Product Name AVerTV Volar Green HD 

Model No. A835 

TV System  Digital TV (  DVB-T ☐  ATSC ☐  DVB-S) 

☐  Analog TV (☐  NTSC ☐  PAL ☐  SECAM) 

Audio Mode  Stereo  Mono  SAP 

AM/FM Radio ☐  Support    Not Support  

Remote Control   Support  

☐  Model 1 (RM-HR)    
☐  Model 2 (RM-FP)   
☐  Model 3 (RM-JC)   
☐  Model 4 (RM-JX)   

 Model 5 (RM-KS)  
☐  Model 6 (RM-KV) 

☐  Not Support 

External Signal 
Source 

☐  S-Video ☐  Composite 

Others  Teletext   MHEG-5 (UK only) 

 EPG  ☐  iEPG (USA only) 

☐  Closed Caption  (USA only)  Digital Subtitle 

☐ CI/CA 

Reference 
Chapter 

 Chapter 1 

 Chapter 2 

 Chapter 3 ( 3.1  3.2.2 3.3 – 3.4  3.5.5 3.6 - 3.14) 

 Chapter 4 (  4.3 - 4.14) 

☐  Chapter 5 

 Chapter 6 (  6.1 – 6.2   6.4) 

 Chapter 7 

 Chapter 8  
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 Chapter 9  

 Chapter 10 

 Chapter 11 

 Chapter 12 

Appendix ☐ Satellite Internet Access (for Windows XP only) 

☐  Universal DVB Plug-in  (for Microsoft XP / Vista MCE only) 

☐  Video Gaming Plug-in  (for Microsoft Vista / Windows 7  
MCE only) 

☐  Video Quality Enhancement Plug-in  (for Microsoft Vista  / 
Windows 7 MCE only) 

☐ Common Interface for Conditional Access (optional) 
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Chapter 2 AVerTV 6 Introduction 
Now, with this product, you can watch TV, listen to the radio, record your favorite 
programs and enjoy other features on your PC. Turn your computer system into a real 
multimedia entertainment center. 

You’ll never miss your favorite ball games, soaps or game shows anymore because the 
TimeShift function performs background recording of a TV program. This means you can 
return and watch from the part of the program where you left off.  

To enjoy high quality TV or radio programs, AVerMedia® product is your best choice.  

Please be noted that the functions or the remote control mentioned in this manual may 
vary depending on the product you purchase and the area you live. 
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Chapter 3 Introducing the AVerTV 6 
Application 

The AVerTV 6 application allows you to watch TV, listen to the radio, record programs, 
and capture still images while you work on your computer. 

3.1 Launching the AVerTV 6 Application 
Run the AVerTV 6 application from the Programs menu. 

  

 

 

To run the application, click Start, point to Programs, choose AVerMedia, AVerTV 6, 
and then click AVerTV 6. Another way is to double-click the AVerTV 6 program icon 

“ ”on the desktop. Or, you can double-click the AVerQuick launcher located in the 
lower right corner of the screen. 

 

 Note: AVerQuick allows to set the desired default application, which means you can 
choose either AVerTV 6 or AVer MediaCenter as the default application when 
double clicking AVerQuick icon . To do this, right click AVerQuick, choose 
“Setting”, and select the preferred application in the “Application” tab.  

AVerQuick 
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3.2 Running the AVerTV 6 Application for the First 
Time 
If this is your first time running the application, the Setup dialog box will appear to 
prompt you to scan for channels. (For details, please refer to the section Scanning 
Channels). 

3.2.1 Scanning for Analog Programs 

1. Select Analog TV (or Programs) on the left pane of the Setup dialog box.   

 Note: Before choosing the signal input, please make sure that your country/region is 
correct. For more information, please refer to “Scanning Channels” in Chapter 4. 

a.First, select an available AVerMedia device in the left pane. 

b.From the Country/Region drop-down list, select your country or region. 

c.Click Apply to save the settings. 

 

(This picture is only for reference.) 

2. On this page, choose the TV option to search only for air channels or select CATV to 
scan for cable channels. 

3. Click New and the Program List dialog box will appear. Type in the desirable name 
and click OK. 

 

4. Click Program Scan for searching for available channels/programs in your area.  
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5. After scanning, the active TV channels will be listed inside the box. Click Apply to 
save the scanned channels. 

6. To exit the current dialog box, click OK. 

 Note: After Media Center Edition scan, you may not be able to lock channels with 
AVerTV 6. Please restart the computer to make it function normally. 
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3.2.2 Scanning for Digital Programs  

1. Select Digital TV (or Programs) on the left pane of the Setup dialog box. 

 

2. Click New and the Program List dialog box will appear. Type in the desirable name 
and click OK. 

 

3. Click Program Scan for searching for available channels/programs in your area. 

4. After scanning, the active TV channels will be listed inside the box. Click Apply to 
save the scanned channels. 

5. To exit the current dialog box, click OK. 

 Note:  

1. This can only supports DVB-T Radio Broadcasts, not the Digital Audio Broadcast 
system. 

2. When scanning digital signals and if your country broadcasts logical channel data, the 
scanned channel will be allocated based on the assigned logical channel number. 
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3.2.3 Scanning for Digital Satellite Programs 

1. Select Digital TV on the left pane of the Setup dialog box. 

 

(This picture is only for reference.) 

2. Choose the switch type that is used by your satellite system. 

3. From the Satellite drop-down list under Input 1, choose the correct satellite. If you 
cannot find the satellite you want but the input port DOES receive satellite signals, 
choose Custom…. Otherwise, choose None.  

4. Click Edit to configure the satellite information. 

5. In the Satellite Information dialog box, type in the satellite’s name in the Satellite box. 

 

(This picture is only for reference.) 

6. Specify the frequencies that you want to scan for available satellite programs.  

There are two ways to do this: 
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 Import the existing frequency data: refer to the section titled  Scanning 
Channels (Importing a Frequency Table) for details. 

 Manually add frequencies: refer to the section titled Scanning Channels 
(Adding Frequencies Manually) for details. If you add frequencies manually, 
please make sure you specify the correct longitude data. 

7. Click OK to exit the Satellite Information dialog box. 

8. From the LNB drop-down list, choose the appropriate setting. 

• None: If you do not use any LNB device, choose this option. 
• Universal Ku Band LNB or C Band LNB: Choose this option if your LNB device 
is this type. 
• Custom: When you choose this option, click Edit to configure your own LNB 
information, such as specifying an LNB name, its frequency type, input range, etc. 
For related data, refer to the documentation that comes with your LNB device. 

9. Repeat steps 1 to 8 if you need to configure Input 2, Input 3, etc. Then click Apply 
to save the settings. 

10. Select Programs under the Digital TV icon on the left pane, and click Program Scan 
to start the scanning process. 

11. Click Apply to save the scanning results. 

 Note: After Media Center Edition scan, you may not be able to lock channels with 
AVerTV 6. Please restart the computer to make it function normally. 

 



AVerTV 6 

10 

3.3 Introducing the User Interface 
The TV monitor allows you to watch live TV or video. 

 
1 Panel On / Off 8 Channel Up/Down 
2 Playback Seek Slider 9 Resize Window 
3 Play / Pause 10 Show / Hide Video Frame 
4 Stop 11 Minimize 
5 TimeShift 12 Full Screen 
6 Record 13 Exit 
7 Volume   

The Control Panel provides button controls for selecting channels, adjusting volume, 
capturing images, and more. It has a panel display that shows the current channel number 
and channel name. 

To display or hide the Control Panel, click the button  located in the lower left 
corner of the TV Monitor.   
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3.4 The Control Panel 

1

2 3 4 5 6 7 8 9 11

17
18

19
20
21
22

2324252627282930

31

161514131210

 
(This picture is only for reference.) 

The table below describes functions of the buttons on the Control Panel. 

 BUTTON FUNCTION 
1 Signal Status /  

Enable or disable Repeat 
Play 

TV/Radio mode: Display the current signal status. 

Playback mode: Right click and enable the Repeat function. The 
system will continuously playback the files in the playlist. 

2 Signal Strength Display signal strength. 

3 Backward Move backwards in intervals. 

4 Channel Loop Return to previously accessed channel. 

5 16-Channel Preview  Display 16 consecutive TV channels on the TV Monitor 
window. 

6 Channel Up/ Down Go to the next upper or lower active channel. 

7 Mute Turn off the sound. 

8 Setup Allows you to: 
* Scan channels. 
* Set the Windows power options. 
* Configure snapshot settings. 
* Customize recording settings. 
* Customize the TimeShift function. 

9 Teletext View Teletext/MHEG-5/Closed Caption information 

10 EPG View EPG information. 

11 Snapshot Capture a single image or a sequence of images. 

12 Forward Skip forward in intervals. 

13 Always on Top Make the TV monitor float over the top of other program 
windows. 

14 Full Screen Show TV/Video programs in full screen. 

15 Program List Display the program list. 

16 Audio Mode Switch between available audio modes. 

17 Schedule Display Schedule dialog box. 

18 Play List Create a playlist of video files to playback. 
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19 Show/ Hide Numeric 
Panel 

Toggle between displaying or hiding the Numeric Panel. 

20 Radio Source Switch to radio mode. (AM/FM or Digital Radio) 

21 Change Video Source Switch between available video sources. 

22 Record Record the current program. 

23 TimeShift / Pause Performs background recording of the live program.  This 
function lets you view the recorded parts, while at the same 
time, recording is in progress. / Freeze the TimeShift 
temporarily. 

24 Next File Play the next file in the playlist. 

25 Previous File Play the previous file in the playlist. 

26 Stop Stop the playback, recording, TimeShift, etc. 

27 Play / Pause Play back recorded video files. / Freeze the playback 
temporarily. 

28 Volume Control Drag your mouse up/down to increase/decrease the volume 
level. 

29 Help View User’s Manual. 

30 Numeric Buttons Select channels/programs. 

31 Playback Seek Drag the slider tab to move to any part of the recorded TV 
program. 
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3.5 Remote Control (Optional) 
After installing drivers and applications, you can use remote control to turn on/off the 
programs, select channels, adjust volume and so on.  
(The remote control can only be used on AVerMedia AVerTV 6 application.) 

 Note: To control two or more than two cards/devices with a remote control, it is   
recommended to enable the multiple infrared receiver function first. To do this, 
right click AVerQuick icon  at the lower right corner of the screen, choose 
“Setting”, “Remote control” tab and select check boxes next to the device 
name. Please check your supported remote control model before activating this 
function. 

3.5.1 Remote Control Buttons (Model 1) (RM-HR) 

1
2

3

4

5

6

7

 

Button Description 
1. Power Turn on/off the application 
2. VOL +/- Volume up/down. 
3. Source Switch between available signal sources. 
4. Numeric Buttons Select a TV channel. 
5. MUTE Turn on/off the sound. 
6. CH ▲/▼ Go up or down to the next active channel. 
7. CH RTN Go to the previously selected channel. 
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3.5.2 Remote Control Buttons (Model 2) (RM-FP) 

 
Button Description 
1. Power Turn on/off the application 
2. Numeric Buttons - Select a TV channel. 

- Under the 16-Channel preview mode, use↑↓← → to highlight the 
intended channel. 

3. CH RTN Go to the previously selected channel. 
4. 16-CH PREV 16-Channel Preview. 
5. VOL▲/▼ Volume up/down. 
6. FULL SCREEN Display TV in full screen. 
7. AUDIO Switch between available audio modes. 
8. ► (Play) Play the last recorded or played file. 
9. ■ (Stop) - End the Playback or recording. 

- End the TimeShift mode and return to real-time TV or Radio
mode. 

10.  (Forward) - Advance the playback. 
- Jump to the Teletext page of the corresponding color according 

to this button. 
11. SLEEP  - Go to the next file in the playlist. 

- Set the time to put your computer in Stand By or Hibernate 
mode. 

- Jump to the Teletext page of the corresponding color according 
to this button. 

12. MENU Display or hide the Control Panel. 
13. EPG Launch the Electronic Programme Guide. 
14. WAKE UP 

 
- Go to the previous file in the playlist. 
- Set the time to bring your computer out of Stand By or Hibernate 

mode. 
- Jump to the Teletext page of the corresponding color according 

to this button. 
15. TELETEXT View Teletext/MHEG-5/ Closed Caption information. 
16. TIMESHIFT 

/PAUSE 
- Freeze the playback. 
- Switch from real-time TV or Radio to TimeShift mode. 

17.  (Rewind) - Rewind the playback. 
- Jump to the Teletext page of the corresponding color according 

to this button. 



AVerTV 6 

15 

18. ● (Record) Switch to PVR mode and record the current program or video into 
your hard drive. 

19. MUTE Turn on/off the sound. 
20. CH ▲/▼ Go up or down to the next active channel. 
21. SNAPSHOT Capture the on-screen image to a bitmap file. 
22. DISPLAY Display information. 
23. Source Switch between available signal sources. 
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3.5.3 Remote Control Buttons (Model 3) (RM-JC) 

 
Button Description 
1. Power Turn on/off the application 
2. Numeric Buttons - Select a TV channel. 

- Under the 16-Channel preview mode, use↑↓← → to highlight the 
intended channel. 

3. CH RTN Go to the previously selected channel. 
4. 16-CH PREV 16-Channel Preview. 
5. VOL▲/▼ Volume up/down. 
6. FULL SCREEN Display TV in full screen. 
7. AUDIO Switch between available audio modes. 
8. ► (Play) Play the last recorded or played file. 
9. ■ (Stop) - End the Playback or recording. 

- End the TimeShift mode and return to real-time TV or Radio
mode. 

10.  (Rewind) - Rewind the playback. 
- Jump to the Teletext page of the corresponding color according 

to this button. 
11.  (Forward) - Advance the playback. 

- Jump to the Teletext page of the corresponding color according 
to this button. 

12.  (Next File) - Go to the next file in the playlist. 
- Jump to the Teletext page of the corresponding color according 

to this button. 
13.  (Previous File) - Go to the previous file in the playlist. 

- Jump to the Teletext page of the corresponding color according 
to this button. 

14. TELETEXT View Teletext/MHEG-5/ Closed Caption information. 
15. TIMESHIFT - Freeze the playback. 

- Switch from real-time TV or Radio to TimeShift mode. 
16. ● (Record) Switch to PVR mode and record the current program or video into 

your hard drive. 
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17. MUTE Turn on/off the sound. 
18. EPG Launch the Electronic Program Guide. 
19. CH ▲/▼ Go up or down to the next active channel. 
20. DISPLAY Display information. 
21. Source Switch between available signal sources. 
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3.5.4 Remote Control Buttons (Model 4) (RM-JX) 

 
Button Description 
1. POWER Turn on/off the application 
2. SOURCE Switch between available signal sources. 
3. Numeric Buttons - Select a TV channel. 

- Under the 16-Channel preview mode, use↑↓← → to highlight the 
intended channel. 

4. CH RTN Go to the previously selected channel. 
5. 16-CH PREV 16-Channel Preview. 
6. VOL▲/▼ Volume up/down. 
7. FULL SCREEN Display TV in full screen. 
8. AUDIO Switch between available audio modes. 
9. MENU Display or hide the Control Panel. 
10. PIP Display or hide the PIP window. 
11. SLEEP  - Go to the next file in the playlist. 

- Set the time to put your computer in Stand By or Hibernate 
mode. 

- Jump to the Teletext page of the corresponding color according 
to this button. 

12. WAKE UP  - Go to the previous file in the playlist. 
- Set the time to bring your computer out of Stand By or Hibernate 

mode. 
- Jump to the Teletext page of the corresponding color according 

to this button. 
13. ■ (Stop) - End the Playback or recording. 

- End the TimeShift mode and return to real-time TV or Radio 
mode. 

14. ► (Play) Play the last recorded or played file. 
15. ● (Record) Switch to PVR mode and record the current program or video into 

your hard drive. 
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16. TIMESHIFT 
/PAUSE 

- Freeze the playback. 
- Switch from real-time TV or Radio to TimeShift mode. 

17.  (Rewind) - Rewind the playback. 
- Jump to the Teletext page of the corresponding color according 

to this button. 
18.  (Forward) - Advance the playback. 

- Jump to the Teletext page of the corresponding color according 
to this button. 

19. TELETEXT View Teletext/MHEG-5/ Closed Caption information. 
20. EPG Launch the Electronic Program Guide. 
21. MUTE Turn on/off the sound. 
22. CH ▲/▼ Go up or down to the next active channel. 
23. SNAPSHOT Capture the on-screen image to a bitmap file. 
24. DISPLAY Display information. 
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3.5.5 Remote Control Buttons (Model 5) (RM-KS) 

 

Button Description 
1. SOURCE Switch between available signal sources. 
2. POWER Turn on/off the application 
3. FULL SCREEN Display TV in full screen. 
4. AUDIO Switch between available audio modes. 
5. ● (Record) Switch to PVR mode and record the current program or video into 

your hard drive. 
6.  (Rewind) Rewind the playback. 
7.  (Forward) Advance the playback. 
8. ■ (Stop) - End the Playback or recording. 

- End the TimeShift mode and return to real-time TV or Radio mode.
9. ► (Play) / PAUSE Play the last recorded or played file. / Freeze the playback. 
10.DISPLAY Display information. 
11.EPG Launch the Electronic Program Guide. (DVB-T only) 
12.VOL＋/－ Volume up/down. 
13.CH ▲/▼ Go up or down to the next active channel. 
14.Numeric Buttons - Select a TV channel. 

- Under the 16-Channel preview mode, use 2 4 6 8 to highlight the 
intended channel. 

15.CH RTN Go to the previously selected channel. 
16.MUTE Turn on/off the sound. 
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3.5.6 Remote Control Buttons (Model 6) (RM-KV) 

 Button Description 

(1) Turn on/off the application. 

(2) Turn off/on the sound. 

(3) Use numeric buttons to select a channel. 

 

(4) 
 

Display TV in full screen. 

(5) Change between available audio modes. 

(6) Main Screen: Use the arrow button to 
navigate all on-screen items. Use OK to 
confirm the selection. (This function is only 
available for AVer MediaCenter) 

PIP Mode: Change size or position of the 
selected screen by the arrow buttons. (This 
function is only available for AVer 
MediaCenter) 

(7) Volume up / Volume down. 

(8) Main Screen: A shortcut to the main menu-- 
“Video”. (This function is only available for 
AVer MediaCenter) 

Teletext Mode: Jump to the teletext page of 
the corresponding color according to this 
button. 

(9) Main Screen: A shortcut to the main menu--
“TV”. (This function is only available for 
AVer MediaCenter) 

Teletext Mode: Jump to the teletext page of 
the corresponding color according to this 
button. 

(10)

 

View Teletext / Close Caption information. 

(11)

 

View EPG information. (This function is only 
available for digital TV) 

(12)
 

Record the current program. 

(13)
 

Play the selected file or temporarily freeze the 
playback. 

 

 

 

 

 

(14) - Go to the previous item in the playlist. 

- Set the time to bring your computer out of 
Stand By or Hibernate mode. (This function 
is only available for AVerTV 6) 
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(15)
 

Move backwards in intervals. 

(16)
 

Skip forward in intervals. 

(17)

 

- Go to the next item in the playlist. 

- Set the time to put your computer into Stand 
By / Hibernate mode, exit the application or 
turn off the computer. (This function is only 
available for AVerTV 6) 

(18)
 

Stop the playback, recording, TimeShift, etc. 

(19) - Switch from real-time TV or Radio to 
TimeShift mode. 

- Temporarily freeze the playback. (This 
function is only available for AVerTV 6) 

(20)

 

- Activate the Picture in Picture (PIP) (This 
function is only available for AVerTV 6)  

- Multi-Channel Display function. (This 
function is only available for AVer 
MediaCenter) 

(21) Capture an image or a continuous sequence of 
images. 

(22) Main Screen: A shortcut to the main menu--
“Pictures”. (This function is only available for 
AVer MediaCenter) 

Teletext Mode: Jump to the teletext page of 
the corresponding color according to this 
button. 

(23) Main Screen: A shortcut to the main menu--
“Music”. (This function is only available for 
AVer MediaCenter) 

Teletext Mode: Jump to the teletext page of 
the corresponding color according to this 
button. 

(24) Channel up and channel down. 

(25)
 

Go back to the previous page. (This function is 
only available for AVer MediaCenter) 

(26)

 

- Go to the main menu. (This function is only 
available for AVer MediaCenter) 

- Exit from CI/CA Information dialog. (This 
function is only available for the device with 
CI/CA function) 

(27) Return to previously accessed channel. 

 

(28) Change between available signal sources. 
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3.6 Changing TV Monitor Resolution 
To switch the resolution of the TV monitor, 
simply right click on the TV monitor. When a 
pop-up menu appears, point to Video and 
choose an appropriate resolution (320x240, 
640x480, 720x480, 720x576). 
 
 

 

3.7 Resizing the TV Monitor Window 
To enlarge or reduce the size of the TV Monitor window, click and drag the lower right 
edge of the window. 

Double-click the TV Monitor window to display it in full screen or click the Full Screen 

button  on the Control Panel.  

When in full screen mode, just double-click anywhere on the screen to revert to the 
normal TV window size. 

3.8 Changing Display Aspect Ratio 
Aspect ratio indicates the ratio of the width of an image 
to its height. To switch the aspect ratio of the display, 
Right click on the TV monitor. When a pop-up menu 
appears, point to Video and choose a desired option.  
4:3 and 16:9 is the two most common aspect ratio of 
home video. You can choose Free to adjust the aspect 
ratio as you want. Or select Keep Aspect Ratio to 
preserve the original width and height of an image.  

 

 

 

3.9 Always on Top 
To make the TV monitor window float over the top of other program windows, right-click 
on the TV monitor. In the pop-up menu, point to Video and choose Always on Top. 
OR,  

Click the Always on Top button  on the Control Panel.  
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3.10 Setting Windows® Power Options 
This option allows you to put your computer in Stand By / Hibernate mode, power off, 
exit the application or log off from the computer while you are away from the computer. 

 Note: 

Stand By: Stand By is a state in which your monitor and hard disks turn off, so that your 
computer uses less power.  

Hibernate: Hibernation is a state in which your computer shuts down to save power but 
first saves everything in the memory on your hard disk.  

Please do the following: 

1. First, Click the Setup button  and in the Setup dialog box, click on the 
Miscellaneous icon on the left pane. 

2. By default, the system is set to enable the Stand By/Hibernation option. What you 
have to do is to choose the desired power-saving settings. If your computer has 
problem with being out of Stand By or Hibernate mode, please clear the Stand 
By/Hibernate option.  

 
(This picture is only for reference.) 

There are two ways to set the time to put the computer into Stand By or Hibernation. 

◆ If the product you purchase with a remote control, you can press the Sleep button 
repeatedly on the remote control. 

◆ Or you can right click on the TV monitor, point to Sleep and select the desired 
mode. Then right click on the TV monitor again, point to Sleep and choose an 
execution time. The time setting will be displayed on the TV monitor. For details, 
please see the description below. 
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Time setting mode Description 
Now Your computer will go into the selected mode in about 10 

seconds. 
Sleep 30/60/90/120 Minute(s) Your computer will go into the selected mode in 

30/60/90/120 minutes. 
Cancel Your computer will return to original settings. 

 

3.11 Setting Time for Turning on the Application 

If your product with a remote control, this function allows you to turn on the application 
at a preset time. 

1. Press the Wake Up button (the green one) on the remote control. 

2. Set the time you want by pressing the Wake Up button continuously. (For more 
information, please refer to the table below.) Then the application will be turned on 
automatically at the time you want. 

 Description 
Cancel Wake Up Disable the Wake Up function. 
Wake Up after 
30/60/90/120 min(s) 

The application will be turned on in 30/60/90/120 
minutes. 
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3.12 Minimize the Application 

To minimize AVerTV 6 application to the system tray (notification area), click the Setup 

button  and in the Setup dialog box, click Personalise icon on the left pane. Then 
Select the Minimize to Tray check box. Otherwise clear the check box to minimize the 
application to a taskbar button. 

 
(This picture is only for reference.) 

3.13 Changing Video Renderer 

To select the video renderer you prefer, click the Setup button  and in the Setup dialog 
box, click Personalise icon on the left pane. Then select the preferred video renderer 
from the drop-down list. 

By default, the renderer is set to Automatic (Overlay Mixer is chosen in Windows XP 
system and Enhanced Video Renderer (EVR) in Windows Vista system.)  

 

(This picture is only for reference.) 
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 Note: 

1. Under Windows Vista system, if you choose Overlay Mixer, the Aero Effect will be 
affected. 

2. You need to choose Overlay Mixer as the preferred video renderer to enable the 
function of display the live TV as your desktop wallpaper. For more information, please 
refer to the section “Setting Live TV as Desktop Wallpaper”. 

 

 

3.14 Setting Live TV as Desktop Wallpaper 
To set the live TV program as your desktop wallpaper, just right click on the TV monitor, 
and point to Video and select Wallpaper.  

 
(This picture is only for reference.) 

 Note: You need to choose Overlay Mixer as the preferred video renderer to enable the 
function of display the live TV as your desktop wallpaper. 
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Chapter 4 TV 
In this chapter, we will introduce methods to scan programs, select a TV/Radio program, 
create a group and so on. 

4.1 Analog TV 
4.1.1 Scanning Channels 

If you haven’t done channel scanning when you first run the application, please follow 
the steps to complete this procedure. 

1. Click the Setup button  and in the Setup dialog box, select an available 
AVerMedia device in the left pane. 

 Note: 

Make sure that your Country/Region is correct. 

a. First, select an available Avermedia device in the left pane. 

b. From the Region/Country drop-down list, select your country or region. 

c. Click Apply to save the settings. 

 

(This picture is only for reference.) 

2. Then select Analog TV (or Programs). On this page, choose the TV option to search 
only for air channels or select CATV to scan for cable channels. 
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(This picture is only for reference.) 

3. Click New and the Program List dialog box will appear. Type in the desirable name 
and click OK. 

 

4. Then Click Program Scan to start the searching process. 

The application comes with a default frequency table therefore the application will 
use this table to search for active channels/programs. If you want to terminate the 
searching process, just click Stop. 

5. You can check the scanning progress from the progress bar. After scanning, the active 
TV/Radio channels will be listed inside the box. Click Apply to save the scanned 
channels. 

 
(This picture is only for reference.) 
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 Note: After Media Center Edition scan, you may not be able to lock channels with 
AVerTV 6. Please restart the computer to make it function normally. 

 

4.1.2 Scanning Channels (For Advanced Users) 

1. Click Advance located at right-lower corner in the Programs Information section. 
Then the Advance Program Configuration dialog box will appear.  

 

2. If you don’t want to miss any channels, click All Frequencies Scan. 

 

3. When a warning message appears, click Yes to continue the procedure or click No to 
abort this operation. 

4. After scanning, new active channels/programs will be memorized and listed in the left 
pane of the dialog box. 

5. Click Apply to save the scanned channel. 

4.1.3 Customize Video Recording Settings 

To customize the video recording settings, please do the following. 
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1. Click the Setup button  and in the Setup dialog box, click Analog TV (or 
Programs) icon on the left pane. 

2. Select the Record Format option. 

3. Determine the video file format you wish to use for saving the recorded video file. 

4. You can use the default format or select New to create your own file format.   

 
(This picture is only for reference.) 

5. Click New and the Format dialog box appears. In the Format dialog box, select the 
file format you want and enter the desired name in the text box. Then click Next. 

 
(This picture is only for reference.) 

6. In the Video dialog box, you can set the video format and audio format. The setting 
options in the Video dialog box will vary according to the video format you chose. 
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(This picture is only for reference.) 

7. Click Finish to save the settings. To abort this operation, click Cancel. 

8. If you want to change the settings of your own file format, click Modify or you can 
click Delete to remove the unwanted file format that you created earlier. 

Information: 

File Format Description 

MPEG-1 Choose MPEG-1 format for video files that are intended for CD-ROM 
playback on a computer or for Internet transmission. MPEG-1 allows 
file compression and offers VHS quality picture. Just about every 
system available today can play MPEG-1 and does not need special 
software or hardware. 

MPEG-2 Videos compressed using MPEG-2 have extremely high quality pictures 
and full CD-quality sound. Choose MPEG-2 format for video files that 
are intended for DVD-ROM playback on a computer or if you want 
broadcast quality videos. 

VCD When you choose this format, the recorded video file will be saved in 
MPEG-1 format that is compliant with VCD standards. Standard VCD 
frame size and frame rate are 352 x 240 pixels at 29.97 fps for NTSC 
and 352 x 288 pixels at 25 fps for PAL. 

DVD When you choose this format, the recorded video file will be saved in 
MPEG-2 format that is compliant with DVD standards. Standard DVD 
frame size and frame rate are 720 x 480 pixels at 29.97 fps for NTSC 
and 720 x 576 at 25 fps for PAL. 

AVI AVI is the most common video file format for playback on the 
computer. It can be saved in uncompressed form if you want high 
quality video, or compressed using any of the available codecs if you 
want to minimize the file size. 

WMA Windows Media Audio. An audio compression format, which can offer 
higher quality than MP3 at the same bit rate. 

WAV A common audio file format for Windows computers. It was created by 
Microsoft and has become a standard PC audio file format.  

WMV WMV is a video format encoded with Microsoft ISO MPEG-4 video 
codec and Windows Media Audio codec. It can be used to provide 
downloadable or streaming video. 

MPEG4-H.264 Videos compressed using MPEG-4 standard which is two or three 
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times more efficient than MPEG-2. This format can be applied to a 
wide variety of applications or networks and systems like HD-DVD, 
Digital TV, Broadcast and Streaming applications. 

iPod A video format base on H.264 standard but has smaller video bit rate. 
It’s an iPod -compatible format.  

--To record program in MPEG-4 format-- 

1. If you want to record program in MPEG-4 format, you need to download codec from 
the website first. We recommend downloading the DivX codec from www.divx.com or 
XviD codec from www.xvid.org. Then install the codec. 

2. Next, run the AVerTV 6 and click the Setup button . In the Setup dialog box, click 
Analog TV (or Programs) icon on the left pane. 

3. Select the Record Format option. 

 
(This picture is only for reference.) 

4. When you click New and the Format dialog box appears. In the Format tab, select 
AVI and enter the desired name in the text box.  

 
(This picture is only for reference.) 

5. In the Video tab, you can choose the desired codec, such as XviD MPEG-4 codec, and 
click OK to confirm your selection. 

http://www.divx.com/�
http://www.xvid.org/�
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(This picture is only for reference.) 

6. If you want to change the settings of your own file format, click Modify. Or click 
Delete to remove the unwanted file format that you created. 

7. Click Apply to save the settings and click OK to exit the current dialog box. To abort 
this operation, click Cancel. 

 Note:  

1. To determine the length of recording and to choose a destination folder in which to 
save the recorded audio, please refer to the section titled Recording Settings in Chapter 
7. 

2. The codecs are not developed by AVerMedia. Therefore, AVerMedia could not 
guarantee the function of MPEG-4 recording. 

4.1.4 Fine Tuning Color and Display Quality  

If the color or picture quality of the TV display needs to be adjusted, please do the 
following. 

1. Click the Setup button  and in the Setup dialog box, click Analog TV (or 
Programs) icon on the left pane. 

2. Select the Display option. 
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(This picture is only for reference.) 

3. Then you can adjust the Brightness, Contrast, Hue, Saturation and Sharpness 
sliders until you get an accurate color. 

Click Save to create your own settings. Next time, you can simply click Preference 
Setting to get your preferred settings. 

4. If you want to revert to default settings, please click Factory Setting. 

4.1.5 Enhancing the Video Quality 

This function can reduce noise. Choose an 
appropriate option listed below. 

 Video Quality Enhancement Enable: 
Activate to improve the video quality.  

 Video Quality Enhancement Disable: 
Disable the video quality enhancement 
function.  

 Video Quality Enhancement Automatic: 
Automatically adjust video quality 
depending on the video screen size.  
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4.2 Digital Satellite TV 
4.2.1 Scanning channels (Importing a Frequency Table) 

You can import any satellite channel data file (*.sdx) downloaded from the Internet into 
the application and then scan the stored frequencies for the latest digital satellite 
programs. 

1. Click the Setup button  and in the Setup dialog box, select an available 
AVerMedia device in the left pane.  

 Note: 

Make sure that your Country/Region is correct. 

a. First, select an available Avermedia device in the left pane. 

b. From the Region/Country drop-down list, select your country or region. 

c. Click Apply to save the settings. 

 

(This picture is only for reference.) 

2. Then select Digital TV → Programs. 
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(This picture is only for reference.) 

3. Click New and the Program List dialog box will appear. Type in the desirable name 
and click OK. 

 

(This picture is only for reference.) 

4. Click Import and the Import dialog box will appear. 

 

(This picture is only for reference.) 

5. Click Browse and the Open dialog box will appear. 

6. Choose the desired channel data and click Open. 
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(This picture is only for reference.) 

7. Then determine how to import the data file by choosing the desired import options. 
The options are explained below: 

Import to program 
list 

This option will add the program data from the 
imported file into the selected input port’s 
program list. With this option enabled, you can 
access the newly added programs without re-
scanning the programs. 

Append to the tail of 
the list 

The imported program data will be added to the 
end of the application’s program list. 

Overwrite 
duplicated program 
data 

The imported program data will overwrite the 
application’s program list when they have the 
same data. 

Overwrite program 
name 

For duplicated program data, the program names 
will be replaced by the imported data. 

Import to satellite’s 
frequency table 

The option will add the frequencies stored in the 
imported file into the selected satellite’s 
frequency table. 

 

 Note: It is highly recommended to choose Import to satellite’s frequency table 
and then re-scan the channels to obtain the latest program data. This is because 
the program data stored in the imported file is not probably the most up to date. 

8. In this example, we select Import to satellite’s frequency table only, and then 
choose the appropriate satellite name from the drop-down list. Click OK. 

9. Then check your LNB’s configurations. Please refer to the section titled  Scanning for 
Digital Satellite Programs for more information. 

10. Click Program Scan to start the scanning process. 

11. Click Apply to save the scanning results. 
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 (This picture is only for reference.) 

 Note: All programs automatically classify into two categories (Digital TV and Digital 
Radio). Select Digital TV to display TV programs; select Digital Radio to display 
radio programs. 
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4.2.2 Scanning channels (Adding Frequencies Manually) 

You can add new frequencies one by one if you do not want to import any existing 
satellite channel data. 

1. Click the Setup button  and in the Setup dialog box, select an available 
AVerMedia device in the left pane.  

 Note: 

Make sure that your Country/Region is correct. 

a First, select an available Avermedia device in the left pane. 

b From the Region/Country drop-down list, select your country or region. 

c Click Apply to save the settings. 

 

(This picture is only for reference.) 

2. Then select Digital TV. 

3. Click Edit next to the satellite name where you want to add new frequencies. The 
Satellite Information dialog box will appear. 

4. Specify the correct frequency, FEC, symbol rate, and polarization. 

 

5. Click Insert. 

6. Repeat steps 1 to 4 if you want to add more frequencies.  

7. Then check your LNB’s configurations. Please refer to the section titled  Scanning for 
Digital Satellite Programs for more information. 
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8. Click OK to exit the dialog box. 

9. Select Programs under the Digital TV icon, and click Program Scan to obtain the 
program data. 

10. Click Apply to save the scanning results. 

4.2.3 Editing or Removing Frequencies 

You can edit or delete the undesired frequencies if the data is incorrect. 

1. Select Digital TV. 

2. Click Edit next to the satellite name where you want to edit frequencies. The Satellite 
Information dialog box will appear. 

3. Then choose one of the following actions: 

To edit a single 
frequency 

Select the desired frequency. Change its 
data, such as its frequency or FEC, and 
then click Modify. 

To delete a 
single frequency 

Select the frequency that you want to 
remove, and click the Remove   button 
located on the lower-left corner. 

To delete the 
whole frequency 
table 

Click the Remove button located on the 
upper-right corner. 

4. Click OK to exit the dialog box. 

4.2.4 Scanning Channels (For Advanced Users) 

1. Click Advance located in the lower right corner of the Program Information section. 
Then the Advance Program Configuration dialog box will appear. 

2. When there are programs/frequencies missing from the program list, select Single 
Frequency or Range Scan. 

3. Specify the correct input port, polarization, frequency and symbol rate. 

4. Click Scan. 

5. After scanning, new active programs/frequencies will be memorized and listed on the 
left pane of the dialog box. 

6. Click OK to save the scanned results. 

7. Click Apply to save the scanned channel. 

 Note: Range Scan may take you a while. Please be patient. 
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4.3 Digital TV 
4.3.1 Scanning Channels 

If you haven’t done channel scanning when you first run the application, please follow 
the steps to complete this procedure. 

1. Click the Setup button  and in the Setup dialog box, select an available Avermedia 
device in the left pane.  

 Note: 

Make sure that your Country/Region is correct. 

a. First, select an available AVermedia device in the left pane. 

b. From the Region/Country drop-down list, select your country or region. 

c. Click Apply to save the settings. 

 

(This picture is only for reference.) 

2. Then select Digital TV (or Programs). 
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(This picture is only for reference.) 

3. Click New and the Program List dialog box will appear. Type in the desirable name 
and click OK. 

 

4. Then click Program Scan to start the searching process.  

The application comes with a default frequency table therefore the application will 
use this table to search for active channels/programs. If you want to terminate the 
searching process, just click Stop. 

5. You can check the scanning progress from the progress bar. After scanning, the active 
TV/Radio channels will be listed inside the box. Click Apply to save the scanned 
channels. 

  
(This picture is only for reference.) 
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 Note: All programs automatically classify into two categories (Digital TV and Digital 
Radio). Select Digital TV to display TV programs; select Digital Radio to display 
radio programs. 

 

4.3.2 Scanning Channels (For Advanced Users) 

1. Click Advance located in the lower right corner of the Program 
Information section. Then the Advance Program Configuration 
dialog box will appear. 

2. When there are channels missing from the channel memory, 
select All Frequencies or Single Frequency. 

3. Once you select Single Frequency, you need to specify the 
correct Frequency, for example 533000 (KHz), and Bandwidth.  

4. Then click Scan. 

5. After scanning, new active channels/programs will be 
memorized and listed in the left pane of the dialog box.  

6. Click Apply to save the scanned channels.  

 

 Note: All Frequencies Scanning may take you a while. Please be patient. 
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4.3.3 Customize Video Recording Settings 
To customize the video recording settings, please do the following. 

1. Click the Setup button  and in the Setup dialog box, click the Digital TV icon on 
the left pane. 

2. Select the Record Format option. 

3. Select recording type. You can use the default format or select New to create your 
own file format. Or you can choose Audio Only for sound recording. 

 
(This picture is only for reference.) 

4. Click New and the Format dialog box appears. In the Format dialog box, select the 
file format you want and enter the desired name in the text box. Then click Next. 

 
(This picture is only for reference.) 

5. In the Video dialog box, you can set the video format and audio format. The setting 
options in the Video dialog box will vary according to the video format you chose. 
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(This picture is only for reference.) 

6. Click Finish to save the settings. To abort this operation, click Cancel. 

7. If you want to change the settings of your own file format, click Modify or you can 
click Delete to remove the unwanted file format that you created earlier. 

Information: 

File Format Description 

Source Format 
(MP2/MP4) 

Record the signal according to the source format, MP2 or MP4. 

MPEG-2: 

Videos compressed using MPEG-2 have extremely high quality pictures 
and full CD-quality sound. Choose MPEG-2 format for video files that 
are intended for DVD-ROM playback on a computer or if you want 
broadcast quality videos. 

MPEG-4: 

Videos compressed using MPEG-4 standard are two or three times 
more efficient than MPEG-2. This format can be applied to a wide 
variety of applications or networks and systems like HD-DVD, Digital 
TV, Broadcast and Streaming applications. 

MP4-H.264 MP4-H.264 is a much more effectively compression techniques in the 
MPEG-4 standard. It delivers excellent video quality across the 
entire bandwidth.  

Audio Only Compress audio in MPEG-2 standard. 

iPod A video format base on H.264 standard but has smaller video bit rate. 
It’s an iPod -compatible format.  

 

—External Video Source— 

1. Click the Setup button  and in the Setup dialog box, click Auxiliary Input icon on 
the left pane. 

2. Select the Record Format option. 
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3. Determine the video file format to use for saving the recorded video file.  

4. You can use the default format or select Other to create your own file format.  

 
(This picture is only for reference.) 

5. Click New and the Format dialog box appears. Then select the file format you want 
and enter the desired name in the text box. 

6. In the Video dialog, you can also select the Video Size or Sample Rate. 

 
(This picture is only for reference.) 

7. If you want to change the setting of your own file format, click Modify. Or click 
Delete to remove the unwanted file format that you created. 

8. Click Apply to save the setting and click OK to exit the current dialog box. To abort 
this operation, click Cancel.  

 

To adjust the quality of the Auxiliary Input display:  

1. Click the Setup button  and in the Setup dialog box, click Auxiliary Input icon on 
the left pane. 

2. Then you can adjust the Brightness, Contrast, Hue and Saturation sliders until 
you get an accurate color. 

Click Save to create your own settings. Next time, you can simply click Setting 
Preference to get your preferred settings. 



AVerTV 6 

48 

3. If you want to revert to default settings, please click Default. 

 

 Note: To determine the length of recording and to choose a destination folder in which 
to save the recorded audio, please refer to the section titled Recording Settings in 
Chapter 7. 

 

4.3.4 Using the EPG Function  
Electronic Program Guide (EPG) is a service that allows you to check the next succeeding 
program schedule and even the program schedules of the whole week. If the EPG service 
is provided in your region/country, simply click the EPG button  to open the EPG 
window.  

First, select the desired program from the Program drop-down list and the EPG window 
will display the schedule for one week. You can also see the related information such as 
program name, time, and description about the program on the right pane of the window. 

In addition, when switching channels, the TV screen can show the current and succeeding 
program information. 

1
2

 

 

 Description 

1 The current program 

2 The program will be recorded 
on the preset time.  

 

Our EPG window also allows you to preset a schedule for watching or recording 

programs. Just select your favorite programs and click Record button  or the Active 

TV Application button . And the system will execute your command on schedule. 

If you want to download the latest program schedule, please click the Update button . 

Click  to sort the EPG list by time or by channel 

4.3.5 Fine Tuning Color and Display Quality  

If the color or picture quality of the TV display needs to be adjusted, please do the 
following. 

1. Click the Setup button  and in the Setup dialog box, click Digital TV icon on the 
left pane. 

2. Select the Display option. 



AVerTV 6 

49 

 
(This picture is only for reference.) 

3. Then you can adjust the Brightness, Contrast, Hue and Saturation sliders until 
you get an accurate color. 

Click Save to create your own settings. Next time, you can simply click Setting 
Preference to get your preferred settings. 

4. If you want to revert to default settings, please click Default. 

4.3.6 Enabling the Subtitle Function 

If your local broadcasters provide a subtitle service, you can 
view them by doing the followings: 

Right click the TV screen, point to Subtitle and choose the 
desired language.  

To hide the subtitles, please right click the TV screen, point 
to Subtitle and choose Close. 
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4.4 Adding and Deleting Channel Groups 
Selecting a Channel Group allows you to switch between the channels of the selected 
group only when pressing the Channel Up/Down button. If you want to add or delete a 
channel group, do the following: 

To add a new channel group:  

1. Click the Setup button  and in the Setup dialog box, 
click Analog TV or Programs icon on the left pane. 

2. Click New and the Program List dialog box will then 
appear (as shown on the right). 

3. Type in a group name and click OK. 

4. Click Program Scan and click Yes to continue the scanning process. 

5. Available channels will then be listed in the Program Information and now you can 
delete the unwanted programs by clearing the check box.  

 

6. Click Apply to save the settings and click OK to exit the current dialog box. Or you 
can click Cancel to revert to the original settings.  

OR, 

If you don’t want to scan programs every time you create a new channel group, you can 
use the Copy function. 

1. From the program drop-down list, select the group that you 
want to duplicate.  

2. Click Copy and the Program List dialog box will appear. 

3. Type in desired name and click OK. 

4. Finally, just like the steps described above, clear the check mark next to the 
unwanted channels. 

To delete a channel group: 

1. Click the Setup button  and in the Setup dialog box, click Analog TV or Programs 
icon on the left pane. 

2. From the program drop-down list, select the name of the group 
that you want to remove. 

3. Click Delete to remove the selected group. 
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4.5 Selecting a TV/ Digital Radio Channel  
There are three ways of switching between TV/Radio channels: 

◆Click the Channel Up/Down buttons (  on the TV monitor window or 

 on the Control Panel) repeatedly until reaching your desired channel.  

◆Click  to open the Numeric Panel (as shown on the right). 
Then click on the Numeric buttons to get your desired 
channel number. 

OR, 

◆Click the Program List button . When the Program Panel appears, first 
choose the desired group from the drop-down list and then double-click on 
the desired channel.  

 
(This picture is only for reference.) 

 Note: Locked channels (eg. Adult channel) are in red text. If you select the 

Lock/Unlock button  located on the bottom right corner of the program panel, the 
system will hide all the pay channels in the program list. (Lock function is only 
available for digital TV.) 
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4.6 Adding and Deleting Program Grouping List 
Click the Program List button . 

If you click on the display mode button  located on the bottom right corner of the 
program panel, the program panel will be switched from Program List to Program 
Grouping List.  

 
(This picture is only for reference.) 

To add or modify grouping list:  

1. Select the Setup button  located on the bottom right corner of the program panel 
and the program group setup dialog will appear.  

2. The channels are listed on the left pane of the program group setup dialog.  

3. Click on the New button  to create or the Delete button  to remove a new 
group shown on the right pane. (The default name is “New Group.” Identical group 
names are acceptable.)  

4. Select the channel you want and then click on the Insert button  to add it to the 
program grouping list or click on the Remove button  to remove it.  

 
(This picture is only for reference.) 

5. Click the Save button  to save the settings or click on the Cancel button  to 
leave without saving.  
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4.7 Adjusting Volume 
On the Control Panel, click and drag your mouse over the Volume meter to 
increase or decrease the volume level. You can also press the + / – keys on the 
numeric keypad to adjust the volume.  

 

4.8 Specifying a Channel Name or Description 
To assign a channel name or specify a description: 

1. Click the Setup button  and in the Setup dialog box, click Analog TV or 
Programs icon on the left pane.  

2. Under the Name column, double-click the text box of the channel you want to assign 
a name or description. 

3. Type in the channel name or description, then press Enter. 

4. Press Apply to save the setting and click OK to exit the dialog box. 

 

4.9 Modifying a Program List Name 
Surely, you can change a program list name. To rename a 
program list, follow the steps described below: 

1. Click the Setup button  and in the Setup dialog box, 
click Analog TV or Programs icon on the left pane. 

2. Click Advance located in the lower right corner of the 
Program Information section. Then the Advance dialog 
box will appear.  

3. Type the desired name in the Program List Name text box. 

4. Press Apply to save the setting and click OK to exit the dialog box. Or press Cancel 
to abort the saving. 
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4.10 Removing Unwanted Channels 
If you want to exclude undesirable channels from your channel list, do the following: 

1.  Click the Setup button  and in the Setup dialog box, click Analog TV or 
Programs icon on the left pane. 

2. Click Advance located in the lower right corner of the 
Program Information section. Then the Advance dialog 
box will appear. 

3. In the Program Information section, select the unwanted 
channel and then click Delete. This channel will be 
removed and that means you won’t be able to access these 
programs anymore. 

 
(This picture is only for reference.) 

OR, 

If you just want to skip a certain channel, do the following: 

1. First, select the unwanted channel in the Program Information section. 

2. Clear the Enable check box so that you will not access that channel when 
you press Channel Up/Down buttons.  

3. However, you can still see the channel in your program list. If you want to watch that 
channel again at some point, just select the Enable check box. 

 

4.11 Using the OverScan Function 
On some broadcast channels, you might see distorted 
lines or black spaces on the top, sides, or bottom of the 
screen.  These video artifacts device from the source 
signal, and can be masked using the OverScan feature.  

To hide the edges of the picture:  

 Right-click on the TV Monitor and choose 
OverScan to have it enable it. 

OR, 

 Click the Setup button  and in the Setup 
dialog box, click Analog TV or Programs icon 
on the left pane. Enable Overscan and specify an appropriate number (0~50) to 
get better quality.  
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(This picture is only for reference.) 

You can see the difference from the pictures below: 

Before using OverScan function After using OverScan function 

  

 

4.12 16-Channel Preview 

 

The 16-Channel Preview function can display 16 TV channels on-screen at the same time. 
You can see clearly which TV programs are currently showing on these channels. 

To preview the channels:  

1. Click  to open the Numeric Panel. 

2. Click the 16-Channel Preview button. 
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3. The screen will be gradually filled up with 16 TV channels, starting from the 
currently selected channel.  

4. Select a channel and press the numeric button “5” on the remote control to view it 
only and freeze the other channels. If you want to continue to display other channels 
just press C letter on the keyboard. 

5. To display a channel on the TV Monitor window, select any one of the 16 channels 
on-screen and double-click on that channel, or use the arrow ↑,↓, ←,  → button of 
your keyboard and then press Enter. You will then be tuned in to that channel.  

6. Or, click the right mouse button or press ESC to return to the originally selected TV 
channel. 

4.13 Changing the OSD Attributes 
1. Click the Setup button  and in the Setup dialog box, click on the Personalise icon 

on the left pane.  

2. In this page, you can customize menu effect (Fade In/Fade Out), set the speed of 
marquee (LCD Speed), and change the appearance of the TV monitor and the control 
panel (Skins).  

 
(This picture is only for reference.) 

3. Then select OSD. In this page, you can choose the TV system from the drop-down list 
for different display information on the TV monitor. You can also adjust OSD color 
(Text, Edge, Background).  
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(This picture is only for reference.) 

4. Click Apply to save settings or click Cancel to abort without settings. 

4.14 Changing Signal Source 
There are two ways to change signal source: 

˙ To switch between TV, radio or external video signals, click the Radio Source button 

 or Video Source button  on the control panel. 

˙ Right click on the left pane of the control panel and a pop-up menu appears. Choose 
the desired signal source. 
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4.15 Sound Controlling (Optional) 
Click the Setup button  and in the Setup dialog box, click Sound Mixer icon on the 
left pane. 

This function provides a variety of sound effects including “Dolby Surround”, “Incredible 
Mono” and “Incredible Stereo”. You can also drag the slider to control the “Stereo”, 
“Bass” and “Treble” level. 

Please be noted this function is only available for analog signals, eg. Analog TV, AM/FM 
and so on. 

 
(This picture is only for reference.) 
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Chapter 5 AM/FM Radio 
If the product you purchase with AM/FM function, then you can read this chapter to learn 
more knowledge about this. 

5.1 AM/FM Radio Controls 
Click the AM/FM Radio button to listen to your favorite radio station. 

Use the following button controls for selecting AM/FM radio channels, adjusting volume, 
scanning AM/FM channels, recording radio programs and more. 

To change back to live TV, click the Video Source button. 

1

2 3 4 5 6 7 8 9 11
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(This picture is only for reference.) 

1. Signal Status/ 
Enable or Disable Repeat 
Play 

14. Play List 

2. Signal Strength 15. Show/Hide Numeric Panel 
3. Backward 16. Video Source 
4. Channel Loop 17. Record 
5. 16-Channel Preview 18. TimeShift / Pause 
6. Channel Up/Down 19. Next File 
7. Mute 20. Previous File 
8. Setup 21. Stop 
9. Forward 22. Play / Pause 
10. Radio Source 23. Volume Control 
11. Program List 24. Help 
12. Audio Mode 25. Numeric Buttons 
13. Schedule 26. Playback Seek 
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5.2 How to Auto Scan AM/FM Radio Channels 

If you are using AM/FM radio for the first time, perform an auto scan to search and 
memorize active AM/FM radio stations in your area. 

To auto scan AM/FM radio stations: 

1. Click the Setup button  and in the Setup dialog box, click AM/FM Radio icon on 
the left pane. 

2. Click New and the Program List dialog box will appear. Type in the desirable name 
and click OK. 

 Note: The system will assign a default name (AM/FM-Radio) if you don’t create a new 
program list before scanning. 

 

3. Click Scan. All active channels will be automatically scanned and memorized. 

4. To terminate the scanning, click Stop. 

5. Click Apply to save the settings and click OK to exit the current dialog box. To abort 
the settings, click Cancel. 

5.3 Manually Scanning Specific AM/FM Channels 
Instead of scanning all channels, you can choose to manually scan one or a few channels 
only. To do this, follow this procedure.  

To manually rescan specific AM/FM radio channels: 

1. Click the Setup button  and in the Setup dialog box, click AM/FM Radio icon on 
the left pane.   

2. Enter the channel frequency that you want to start scanning in the text box. 

 
(This picture is only for reference.) 

3. Select 0.01 MHz, 0.05MHz or 0.1MHz as your tuning increment.  

4. Click  to scan upward or  to scan downward from the selected channel 
frequency. The scanning will stop when the application finds the closest ACTIVE 
AM/FM frequency. 

5. Or click  or  to increase/decrease the frequency to search your preferred 
channel. 

6. Click the Modify button if you’d like to keep the newly scanned frequency. 
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5.4 Selecting a Channel 
To select a channel: 

1. Click  to open the Numeric Panel. 

2. There are a number of ways to select a channel: 

‧ Click on the Numeric buttons to select a channel. 

‧ Click the Channel Up/Down button repeatedly until reaching your desired 
channel. 

OR, 

‧ Use the numeric keys on your keyboard to select a channel. 

5.5 Skipping Unwanted Channels 
If you want to exclude undesirable channels from your AM/FM channel list, do the 
following: 

1. Click the Setup button  and in the Setup dialog 
box, click AM/FM Radio icon in the left pane. 

2. In the Program column, click the unwanted 
channel. The check mark will be removed, 
indicating that the channel will be excluded from 
your channel list and that you won’t be able to 
access and hear them through the Channel Up/Down button. 

5.6 Adding a Radio Frequency  
If the desired channel cannot be found through scanning, follow the instructions below. 

1. Click the Setup button  and in the Setup dialog box, click AM/FM Radio icon in 
the left pane. 

2. Specify the correct frequency in the text box (as shown below) and click Save. 

 

5.7 Modifying a Channel Name 
You can manually modify any existing AM/FM radio channel. 

1. Click the Setup button  and in the Setup dialog box, click on the AM/FM Radio 
icon in the left pane. 

2. Double click on the Name column of the existing AM/FM channel which you want to 
modify. 

3. Enter the name or description you want in the provided text box and then press Enter. 
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4. To modify more channels, repeat step 2 to 3. 

5. Click Apply to save the settings and click OK to exit the current dialog box. 

5.8 Adding and Deleting Channel Groups 
Selecting a Channel Group allows you to switch between the channels of the selected group 
only when pressing the Channel Up/Down button. If you want to add or delete an AM/FM 
channel group, do the following: 

To add a new channel group:  

1. Click the Setup button  and in the Setup dialog box, click AM/FM Radio icon in 
the left pane. 

2. Click New and the Program List dialog box appears. Type in a group name and click 
OK. 

3. Now you can start to scan AM/FM radio channels and manage the scanned AM/FM 
data for this new channel group. For more information, refer to How to Auto Scan 
AM/FM Radio Channels. 

4. To add more channel groups, repeat steps 2 to 3. 

To delete a channel group: 

1. Click the Setup button  and in the Setup dialog box, click on the AM/FM Radio 
icon in the left pane. 

2. From the drop-down list, select the name of the group that you want to remove.  
3. Click Delete to remove the selected group. 

5.9 Customizing Audio Recording Settings 
To customize audio recording settings: 

1. Click the Setup button  and in the Setup dialog box, click on the AM/FM Radio 
icon in the left pane. 

2. Then select Record Format. You can use the default format or select New to create 
your own file format. 

 
(This picture is only for reference.) 

3. Click New and the Format dialog box appears. In the Format dialog box, select the 
file format you want and enter the desired name in the text box. Then click Next. 
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(This picture is only for reference.) 

4. In the Video dialog box, you can set the audio format. The setting options in the Video 
dialog box will vary according to the audio format you chose. 

 
(This picture is only for reference.) 

5. Click Finish to save the settings. To abort this operation, click Cancel. 

6. If you want to change the settings of your own file format, click Modify or you can 
click Delete to remove the unwanted file format that you created earlier. 

 Note: To determine the length of recording and to choose a destination folder in which 
to save the recorded audio, please refer to the section titled Recording Settings in 
Chapter 7. 
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Chapter 6 TimeShift  
The TimeShift function performs background recording of a TV /Radio program, and lets 
you return and watch any part of the recorded program. At the same time, the live TV 
/Radio program continues to be recorded and played back so you won’t miss any part of 
the show. You can also advance forward to skip commercials or rewind to replay scenes 
one more time. 

6.1 TimeShift Controls 
Use the following button controls in the Control Panel to start recording a live program, 
play back the program from where you left off, advance forward, rewind, and more. 

1 2 3 4 5 6

78

 

 BUTTON FUNCTION 

1 Backward Click to move backward in intervals 

2 Playback Seek Drag the slider tab to move to any part of the recorded 
program. 

3 Volume Drag your mouse up/down to increase/decrease the volume 
level. 

4 Mute Turn off the sound. 

5 Setup Allows you to: 

* Scan channels. 
* Set for Windows power option. 
*Configure snapshot settings. 
*Customize recording settings. 
*Customize the TimeShift function. 

6 Forward Click to skip forward in intervals 

7 TimeShift / Pause Click to perform background recording of the live program 
and play it back simultaneously. / Click to temporarily 
freeze the playback. 

8 Stop Click to terminate recording and return to the live 
program. 
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6.2 Customizing TimeShift Recording Settings 
Before you start using the TimeShift function, first check its recording settings to see if 
they fit your needs. 

To check and customize recording settings: 

1. Click the Setup button  and in the Setup dialog box, click the Storage icon on 
the left pane. You will then see the following settings. 

 
(This picture is only for reference.) 

2. By default, TimeShift performs recording of the TV program by creating a temporary 
video file and deletes this file once you click the Stop button. If you want to save 
the video file, select the Keep TimeShift Files check box. 

3. In the Record section, you can determine your file name format, recording time, file 
size and destination folder. 

4. Click Apply to save the new settings and click OK to exit the current dialog box. Or, 
click Cancel to use the original settings. 

 

6.3 Customizing TimeShift Video Quality Settings 
(Analog TV only) 
To customize video and audio quality settings: 

1. Click the Setup button  and in the Setup dialog box, click the Timeshift icon on 
the left pane.  

2. Determine the video and audio quality for timeshifting. 
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(This picture is only for reference.) 

3. If you want to revert to default settings, please click Default. 

4. Click Apply to save the new settings and click OK to exit the current dialog box. Or, 
click Cancel to use the original settings. 

 

6.4 Using the TimeShift Function 
To pause the live program: 

1. Click the TimeShift button  on the Control Panel. The application will begin to 
record the program. 

2. When you want to rewind, use the Playback Seek slider bar to move back to the 
part you want to watch or listen to again. Click and drag the slider tab to the left 
until you see the part of the show you wish to watch or listen to, then release the 
mouse button. 

 

3. You can also click the Backward button  to move backward in fixed intervals until 
you reach the part where you left off. 

4. To advance forward and skip some parts of the recording (for example TV 
commercials), drag the slider tab to the right. You can also click the Forward button 

 to move forward in fixed intervals. 

5. To temporarily pause the playback, click the Pause button . Click the Pause 
button again to resume. 

6. To return to the real-time viewing or listening of the live program, click the Stop 

button . This switches off the TimeShift function and returns you to live program. 
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Chapter 7 PVR 
You can use your computer as a personal video recorder, and record your favorite TV 
programs or capture video from an external source into your hard drive. Besides, you can 
also divide the recording files in proper sizes to facilitate burning onto removable optical 
media, such as CD-R and DVD disks.  

7.1 PVR Controls 
Use the following button controls for recording and video playback. 

1 2 3 4 5 6

7

8

911 10

 

 BUTTON FUNCTION 
1 Backward Click to move backward in intervals. 

2 Playback Seek Drag the slider tab to move to any part of the recorded file. 

3 Volume Drag your mouse up/down to increase/decrease the volume level.

4 Mute Turn off the sound. 

5 Setup Allows you to: 
* Scan channels. 
* Set Windows power options. 
* Configure snapshot settings. 
* Customize recording settings. 
* Customize the TimeShift function. 

6 Forward Click to skip forward in intervals. 

7 Play List Click to create a playlist of video files to play back. 

8 Record Click to start recording. 

9 Play Previous/Next File Click to go to the previous/next video file in the playlist. 

10 Stop Click to stop recording or playback. 

11 Play / Pause Click to playback. / Click to temporarily freeze the playback. 
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7.2 Recording Settings 
Before recording, check if the settings meet your needs.  

1. Click the Setup button . In the Setup dialog box, click the Storage icon on the 
left pane. 

2. By default, the system sets the recording “Date” and “Time” as the file name format. 
To create your own file name format, please click Custom. 

3. The Duration option allows you to specify a recording duration otherwise the system 
will record the largest clip that your hard drive can accommodate. 

4. This application lets you to divide the recording files in parts for burning onto 
removable optical media, such as CD (650 MB) and DVD (4096 MB) discs. Enable 
the Split File Size option and select the appropriate video file size from the drop-
down list so that each video file will not exceed the limit. Or you can choose 
Custom to assign the file size you want. 

5. Determine the destination folder. Click  to choose a folder you want. 

6. Click Apply to save the settings and click OK to exit the current dialog box. To 
abort this operation, click Cancel. 

 Note: To hide the sound of the TV program when recording, click the Mute button  
on the Control Panel. 

7.3 Using the Recording Function 
To record a TV/Radio program that you want, do the following: 

1. Click the Record button  on the Control Panel. 

2. You can click the Stop button  to terminate the recording and return to the live TV 
program. 

7.4 Playing the Recorded Programs 
Each TV program that you recorded will be saved as a video file in the assigned 
destination folder. 

To play back the recorded video files: 

Click the Play button  or drag the recorded video file to AverTV TV monitor or User 
Panel to play back. 

OR,  

Drag the recorded video file to AVerTV desktop icon to run the application and play back. 

 

OR, 

(1) Click the Play List button , and you may see some recorded video files listed in the 
top rightpane of the Playback List window.  

(2) To add more video files to the playback list, first navigate the file in the left pane to find 
the folder that contains the desired video files. When you have located the folder, the 
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media files will then be displayed on the top right pane. Select the files that you want, 
then click Insert, or click Insert All to add all media files in the folder to the playback 
list. 

(3) To delete files from the Playback List, select them from the list in the right bottom pane 
and click Delete, or click Delete all to delete all files in the playback list. 

 
(This picture is only for reference.) 

7.5 Picture-in-Picture Display 
With the picture-in-picture window feature, you will be able to play back recorded video 
files, and at the same time, watch live TV. 

To enable PIP function, right click the TV monitor, select PIP and choose Enable. You 
can also point to PIP and select a desired position of the PIP window. Select Close to 
disable the PIP function. 

 

Position Description 
Top-left Corner /  Display the PIP window on the top-left corner 
Top-right Corner /  Display the PIP window on the top- right corner 
Bottom-left Corner /  Display the PIP window on the bottom-left corner 
Bottom-right Corner /  Display the PIP window on the bottom-right corner 
Movable /  Resize the PIP window and separate it from the main 

window 
 

By default, you will be able to play back recorded video files on the main window, and at 
the same time, watch live TV in the PIP window. If you want to switch the video 
playback to the PIP window and the live TV to the main window, press the button . 
You can also press the button  to fix the size of the PIP window and the distance 
between the main window and the PIP window. To exit the PIP window, press . 
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Chapter 8 Image Capture 
While you watch TV or recorded video from your PC monitor, you can use the AVerTV 6 
application to capture images for your document, presentation or web page. 

8.1 Before Capturing 
Before you start capturing images, first set the destination folder for saving captured 
images. 

Click the Setup button , and select the Snapshot icon in the left pane. Then click  
to choose a folder where you want to save captured images. 

8.2 Capturing a TV/ Video Image 
To capture a still image, click the Snapshot button on the Control Panel. The Album 
will then appear, displaying thumbnails of the captured image. 

 

 BUTTON 
1 Wallpaper 

2 Save as 

3 Remove 

4 Remove All  

To capture another image, click the Snapshot button on the Control Panel again. New 
thumbnails will be added to the Album as you capture more images. 

By double-clicking on the thumbnails, you can view images in a full-screen window with 
default image viewer. 

To display the captured image as your desktop wallpaper :  

1. Select the thumbnail of the desired image and then click the Wallpaper button 
. 

2. The selected image will be displayed as your wallpaper, the background of your 
desktop. 

To save the captured image: 

1. Select the thumbnail of the image and then click the Save As button . The Save 
As dialog box will then appear. 
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(This picture is only for reference.) 

2. From the File Format drop-down menu, select the format for saving the captured 
image.  

3. Choose the Color format. 
• Choose 24-bit to capture image in 16M colors. 
• Choose 8-bit to capture image in 256 colors. 

4. Click Browse to scan for folders and select a destination 
location for saving the image. Then specify a file name for saving the captured image. 

 
(This picture is only for reference.) 

5. Choose the image size. 
• In the Size section, select the Standard option and choose a desirable 

image size from the drop-down list. 
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(This picture is only for reference.) 
• If you want to set your own image size, select Customize and enter the 

image Width and Height. If you want to maintain relative width and 
height, select the Keep Proportion option. Choose a measurement unit 
from the Unit drop-down list. You can specify any image size you want. 
The maximum capture size can be 1600×1200. 

 
(This picture is only for reference.) 

6. Click OK to save the image. Click Cancel if you do not want to save the image. 

8.3 Multiple Image Sequence Capture 
To capture a continuous sequence of images, do the following: 

1. Click the Setup button . In the Setup dialog box, click the Snapshot icon in the 
left pane. 

 
(This picture is only for reference.) 

2. In the Number of Pictures box, specify the number of images you want to capture. 

3. In the Interval Time box, specify the interval between captures. For instance, if you 
specify 10 seconds, an image will be captured every 10 seconds. 

4. On this page, you can choose the file format, destination folder, file name format and 
image resolution in advance. 

5. Click Apply to save the new settings and click OK to exit the current dialog box. Or 
Click Cancel if you do not want to change the settings. 

6. Click the Snapshot button  on the Control Panel to start capturing. 
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Chapter 9 Teletext / MHEG-5 
Teletext or MHEG-5 (digital Teletext) makes TV viewing a unique experience. It views 
teletext broadcast from your television programs offering the most updated information 
on TV Schedules, News, Stock Market Prices, Concert & Theatre information and so on. 
Teletext/MHEG-5 information may not be available if there is no such service provided in 
your area. 

9.1 MHEG-5 Support (UK Digital Teletext Service) 
Click Teletext button on the control panel and then the MHEG-5 Window will appear. 

To activate the service, simply press the R key or red button once this window opens. 

 

The table below is a list of keyboard shortcuts that you may find useful while using 
MHEG-5. 

Press Correspond to 
R Red 
G Green 
Y Yellow 
B Blue 
0~9 / ↑ ↓ ← → numeric keys / arrow keys 
T TEXT 
ESC Cannel 
Enter Select 

 Note: MHEG-5 Support will only function in the UK. 



AVerTV 6 

74 

9.2 Teletext 
9.2.1 Customize the Display Mode  

1. Click the Setup button  and in the setup dialog box, click the Teletext icon in 
the left pane. 

2. From the Display Mode drop-down list, choose Other Window Display to open 
a new Teletext window or choose Main Window Display to overlay the Teletext 
window on the TV monitor. 

3. Select the Transparent check box to make the Teletext window transparent. 

 
(This picture is only for reference.) 



AVerTV 6 

75 

9.2.2 Overview  

Click the Teletext button  on the control panel to open the Teletext application as 
shown below. For more information about Teletext, please see below in this chapter. 

1

2

3

4

5

 

 BUTTON FUNCTION 
1 Menu Bar This contains the names of the available drop-down list option menus. To 

access any of the menu items, simply click on it or hold down Alt and 
press the first character of each item. 

2 Toolbar It includes buttons that gives quick access to perform certain frequently 
used functions from the Menu Bar. 

3 Status Bar The status bar is located in the lower left corner of the window. It 
contains a short text message or explanation of the currently selected 
menu command. 

4 Title Bar This is located at the top of the window. It contains the current displayed 
page number or in hexadecimal page number of an active window. 

5 Teletext 
Browser 

Teletext information is displayed in this area. The information would be 
the TV schedules, news, stock market reports, concert & theater 
information and so on. 
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9.2.3 Toolbar Buttons  

Lock Sub page  
Locks the current sub page. The upcoming transmitted sub pages will be stored in the 
Teletext Cache for later use.  

Previous Sub page/ Next Sub page 
Switches to the next or the previous sub page.  

Home (Ctrl+H) 
Connects to the teletext home page which always goes to page 100, but page 100 may not 
be the primary teletext source. 

Previous Page (-) / Next Page (+)  
Displays the preceding or the succeeding teletext in hexadecimal page number. 

History Back / History Forward 
Retrieves the previous page in the history list.  

Moves a page forward in the history list. The command is usable after one or more back 
steps in the history list. 

TV Scale  
Changes the proportion of the Teletext window to 4 by 3. 

Always On Top 
Makes Teletext Window float over the top of other applications. 

Teletext File  
Switches between the Teletext file which is opened from the previously saved file and the 
most recent Teletext information.   

9.2.4 LED Lamp  

Different LED color indicates different states. 

Left LED Lamp:  
Gray -- The system does not receive the teletext broadcast data.  
Green -- The system is receiving the teletext broadcast data. 
Right LED Lamp:  
Green -- The cache in Teletext application is running less than 90% usage.  
Yellow -- The cache in Teletext application is running over 90% usage. 
Red -- The cache in Teletext application is running out. 
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9.2.5 Using Teletext 
The following briefly describes how to use the Teletext feature.  

Teletext Page 
There are two page numbers displayed on the first line of each teletext page. The page 
number on the left is the page number that you have selected or keyed in. The other one 
in the middle of line is the page number of the currently displayed teletext data. 

The newly selected page number will appear on the upper left corner of the page. 
Sometimes, this may take a while to retrieve the newly selected teletext page.  There will 
be no changes on the page when there is no page data transmitted with the number you 
have selected. 

A teletext page can be selected with one of the following methods: 

 Key in the hexadecimal or teletext page number using the numeric buttons of 
your keyboard or AVerMedia TV remote control. 

 Press the + (positive) or  – (negative) button to move to the succeeding or 
preceding teletext page. 

Copying a Teletext Page 
1. Simply click and drag over the text or the area that you want to copy using the 

mouse.  

2. Choose Copy from the Edit menu (Alt+E, C) or press Ctrl+C.  

3. You can then paste the contents of the teletext page in TXT or BMP format to a 
document you are working with. 

Saving a Teletext Page 
Some teletext pages include a number of subpages. If the file has subpages, teletext will 
also save the existing subpages. 

1. A teletext page can be saved using one of the following ways: 

● To automatically save the file using the displayed teletext page as the filename 
and the default file format, choose Save from the File menu or press Ctrl+S.  

● To save the file by specifying your own filename and different file format, 
choose Save As from the File menu or press Ctrl+A. 

2. A save as dialog box will appear: 
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3. Select the file format to use for saving the teletext page. You can save the 
teletext page in : 

  TXT Text file format 
  BMP Windows bitmap file format 
  TLT Teletext file format 
  TLX Teletext file format 

4. Enter a filename and click OK. 

Opening a Teletext Page 
1. Choose Open from the File menu or press Ctrl+O. 

2. From the Open dialog box, select the file containing the teletext page you want 
and click OK. 

 
 

Opening Another Teletext Window 
To open another teletext window, choose New Window from the File menu or press 
Ctrl+W. 

Closing the Active Teletext Window 
Choose Close Window from the File menu or press Ctrl+L to close the active teletext 
page window. 



AVerTV 6 

79 

Chapter 10 Scheduler 
The Scheduler allows you to create a list of preset schedules for watching and recording 
your favorite TV/Radio programs. You can set the day and time to record the TV/Radio 
program and specify the length of recording. 

To run this application, click the Schedule button  on the Control Panel. Then the 
Scheduler dialog box will appear.  

1

2  

 

 

 BUTTON 

1 Current Time 

2 Selected Schedule  

The check box next to the Program column (as shown at right) 
indicates the schedule will be executed at a preset time. Once the 
application starts to execute a scheduled task, the system will clear 
the check mark automatically. If you want to skip the schedule 
temporarily, just clear the check box. 

10.1 Schedule Management 
This displays a list of preset schedules you have created.  

Modify  

Select a preset schedule and click this button to make changes.  

Delete  

Click this to delete the selected schedules. 

Delete All  

Click this to delete all schedules. 
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10.2 Adding Schedules 
To create a new schedule: 

1. Click the Add button . 

2. The following dialog box will then appear:  

 
(This picture is only for reference.) 

3. Type the desired name in the Schedule Name text box. 

4. From the Function drop-down list, select Activate AVerTV to watch a TV program or 
listen to a radio broadcast. Otherwise, select Record to save a TV/Radio program for 
future viewing/listening. You can also select Silent Record which means the system 
will perform background recording instead of activating the TV/Radio program. 

 Note: If you select Silent Record, when the application is performing the recording 
task, the icon  will appear on the task bar (the lower right corner of the screen). To 
immediately watch or listen to the TV/Radio program which is being recorded, just 
double-click this icon.  

5. In the After Record-Schemes, it automatically switches to the selected power control 
mode when the schedule recording is completed. Choose an appropriate power control 
status listed below: 

‧ Watch TV: Switch to real-time TV mode. 
‧ Exit: Turn off the AVerTV Application. 
‧ Stand By: Turn off your monitor and 

hard disks. 
‧ Hibernate: Save everything and then turn off your computer. 
‧ Shut Down: Turn off your computer. 

 Note: If you choose Watch TV from the drop-down list, after completing the Silent 
Record task, the icon  will appear on the task bar (the lower right corner of the 
screen). Just double-click this icon, you can immediately watch live TV or listen to the 
radio. 

6. In the Program Setting section, select the device, video source, group and channel you 
want. 
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7. Set the schedule to tune in live TV or to perform recording. You can set the schedule 
on Once, Daily or Weekly. 

‧ Choose Once to perform schedule at a preset day and a preset time. 
‧ Choose Weekly to perform schedule every week, at a preset day and time. 
‧ Choose Everyday to perform schedule everyday at a preset time. 

8. If you choose Activate AVerTV in step 4, click Insert to complete the settings. If 
you choose Record or Silent Record, you need to do the following. 

9. Click the Advance icon. 

10. In the Record Setting section, you can determine the file format, recording duration, 
file size, destination folder or audio mode. 

11. Click Insert to save the new schedule or click Cancel to abort the saving. 



AVerTV 6 

82 

Chapter 11 Hot Keys   
Hot Key Description Function 

UP/DOWN ARROW Channel or Frequency 
Up/Down 

Press to go to the next upper/lower 
TV/Radio channel. 

L Channel Loop Press to go to the previously accessed 
TV/Radio channel.  

NUMERIC KEYS Select Channel  Use NUMERIC KEYS to directly enter 
the TV/Radio channel number. 

ESC Stop 
or, Change back to Normal 
View 

Stop (playback, recording, TimeShift, 
or 16-Channel Preview). Or change full 
screen back to normal view. 

F1 Help Open the Users Manual. 

F2 Minimize Minimize the application and an icon will 
appear in the notification area. To return 
to the previous screen, double click the 
icon again. 

F5 Full Screen Show TV/Video in full screen.  

F6 Display (OSD) information Display information on the TV monitor.

F8 16-Channel Preview Press to perform 16-Channel Preview 
function. 

+/- (on your numeric 
keypad) 

Volume Press to increase or decrease the volume 
level. 

LEFT/ RIGHT 
ARROW 

Rewind/  
Fast Forward 

Press to rewind or fast forward (for 
playback and TimeShift). 

A Audio Mode  Choose between available languages. 

D Show/Hide the Control Panel Toggles between showing and hiding 
the control panel. 

M Mute Turn off/on the sound. 

Ctrl + N Play Next File Play the next file in the playlist. 

Ctrl + P Play Previous File Play the previous file in the playlist. 

Ctrl + R Record Start recording. 

P Play / Pause Play/Pause (for playback, recording, 
and TimeShift). 

Ctrl + S Snapshot Capture an image (or a continuous 
sequence of images). 

Ctrl + T TimeShift Enable the TimeShift function. 

Insert  Transparent Make Teletext window transparent. 
(Only available for Teletext overlay 
mode.) 

Page Up Previous page Go to the preceding Teletext page. 

Page Down Next page Go to the succeeding Teletext page. 

Home Home page Go the Teletext home page. 
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Chapter 12 Customer Service  
The AVerTV 6 application provides a convenient tool, which allows users to contact 
AVerMedia’s customer service department easily via the website. Please make sure that 
you have already connected to the Internet.  

To contact the customer service: 

1. Right-click on the TV monitor window. When a 
menu list pop-up, choose About (as shown at right).  

2. When an information dialog box appear, click  to 
access the product information webpage. Or you can 
click  to connect to our technical support webpage. 

 

3. To exit the current dialog box, click . 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

www.avermedia.com 
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Appendix 
 Satellite Internet Access (for Windows XP only) 
Satellite Internet Access allows users to get faster connection to the internet via satellite. 
Simply follow the steps below: 

 
If you are using one specific satellite service to watch satellite TV 
and access to the internet, click Insert > Import to apply the 
existing satellite data from AVerTV 6 or AVer MediaCenter and 
you may skip step 1 to 4. 

 

1. In the Satellite Internet Access dialog box, click 
Insert and an Insert dialog box appears. 

2. Enter the desired name in the Service Name text 
box. 

3. In the Switch Type section, choose the type that is 
used by your satellite system. 

4. In the LNB (MHz) section, configure your own 
LNB information, such as input range.  

5. In the Tuner section, specify the correct frequency, 
symbol rate, and polarization. 

6. In PID section, enter the correct PID value. If there 
are PID values missing, it is recommended to use 
Auto-Detect to search for more PID values. 
After searching, all active PID will be displayed 
inside the box.  

7. Click OK to save the settings or Cancel to leave 
without saving. 

8. In the Satellite Internet Access dialog box, click 
Edit to modify the data or Delete to permanently 
remove the selected data.  
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Different lamp indicates different status: 

˙Dark Red indicates your satellite configuration is at wrong setting.  

˙Dark Green indicates the satellite signal is available but no 
Internet data transmission occuring that time. 

˙Light Green indicates you have connected to the Internet 
successfully.  

9. Click Advance to customize the Satellite Internet Access.  
- Start to Tray: Select to minimize the application and an icon will appear in the 

notification area. 
- Notify When Close: Select to inform you when exiting the application. 
- MAC Address: By default, the system detects MAC value automatically. Or click 

EDIT to enter your MAC value.  

 
 

FAQ 

Q : Before setting up, what should I prepare? 

A : Satellite Internet Service requires you to have an ISP account and a Modem for 
sending commands to the Internet.  

Q : Should I pay for Satellite Internet Access? 

A : The charge for the service will be mainly determined by your Internet Service 
Provider (ISP). For details about the fee rate, please contact your ISP.  

Q : Why can’t I activate Satellite Internet Access? 

A : You cannot activate AVerTV 6/AVer MediaCenter and Satellite Internet Service at 
the same time so please make sure you have already exited the AVerTV 6.0/ AVer 
MediaCenter. 

Q : Why can’t I still access the Internet after setting up? 

A : Our default IP address is 192.168.14.61. If there is something wrong with connecting 
to the website, please make sure that there is no IP address conflict in your computer. 

Q : How can I get the PID value? 

A : Please contact your ISP to obtain the related data. 

Q : Where can I find the LNB information? 

A : Refer to the documentation that comes with your LNB device. 
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 Universal DVB Plug-in (for Microsoft / Vista MCE only) 
Some devices, such as AVerTV Satellite PCI / AVerTV Satellite Hybrid + FM, are shipped with a 

“Universal DVB” plug-in program for Windows XP or Vista Media Center Edition (MCE), providing 

you to watch or record DVB-S programs (and analog programs for AVerTV Satellite PCI / AVerTV 

Satellite Hybrid + FM) directly under MCE UI.  

 

 Video Gaming Plug-in (for Microsoft Vista / Windows 7 
MCE only) 

MCE “Video Gaming Plug In” support is for Vista MCE only. After installing the driver, you can access 

it through the program library in Online Media. This function enables you to watch composite/S-Video 

signal source or play games in Vista MCE platform. (Playing games with MCE may cause delay, but you 

can choose “Video Gaming Plug In” to avoid it and enjoy real-time game play.) 

11..  Start the Media Center in Vista. 

22..  Select “Online Media”  “program 
library”. 

 

 
33..  Select “Video Gaming Plug In”. 
 

 
44..  Select the video source you want to view 

via “Video Gaming Plug In”. 

55..  Click button  to view images in a full-
screen window. Press ESC to exit the full-
screen mode. 
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 Video Quality Enhancement Plug-in (for Microsoft Vista / 
Windows 7 MCE only) 

MCE “Video Quality Enhancement Plug-in” support is for Vista MCE only. After installing the driver, 

you can access it through the program library in Online Media. This function enables you to adjust the 

Brightness, Contrast, Hue, Saturation and Sharpness until the image color is accurate. The setting you 

made will be applied to Analog TV, and composite/S-Video signal source. 

11..  Start the Media Center in Vista. 

22..  Select “Online Media”  
“program library”. 

 

 
33..  Select “Video Quality 

Enhancement Plug-in”. 
 

 
44..  Select the item you want to adjust. 

 
55..  Use the following buttons to adjust 

the value of the item. 

 

••  Decrease Brightness and Hue values 
by 32. 

••  Decrease Contrast and Saturation 
values by 16. 

••  Decrease Sharpness value by 8. 

 

••  Decrease Brightness and Hue values 
by 16. 

••  Decrease Contrast and Saturation 
values by 8. 

••  Decrease Sharpness value by 4. 

 ••  Decrease the item value by 1. 
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••  Reset the item value back to its 
default. 

 ••  Increase the item value by 1. 

 

••  Increase Brightness and Hue values 
by 16. 

••  Increase Contrast and Saturation 
values by 8. 

••  Increase Sharpness value by 4. 

 
••  Increase Brightness and Hue values 
by 32. 

••  Increase Contrast and Saturation 
values by 16. 

••  Increase Sharpness value by 8. 

  
 

66..  Click button  to reset all items 
back to their default settings. 

77..  Or click button  to save all the 
settings. 

88..  If you want to exit without saving, 

click button . 
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 Common Interface for Conditional Access (optional) 
The AVerTV device with CI/CA enables you to watch DVB-S scrambled pay channels when you have a 

subscription SmartCard and an appropriate CAM (Conditional Access Module). How many scrambled 

channels you can watch will vary depending on the SmartCard you purchase.  

1. If the device is connected with CAM, the Initializing CI dialog will appear and begin the process of 

Initializing CI as soon as the application is turned on. 

 

2. Configure DVB-S TV signal and scanning channels. 

3. After the Initializing CI process is done, when you switch to the scrambled pay channel, the 

Common Interface dialog may appear for you to key in the pincode.  

 

4. To see the CI/CA information, right click on the TV monitor, and choose CI/CA information. The 

Common Interface dialog will appear. (The messages included in the Common Interface dialog 

will vary depending on the CAM and SmartCard you purchase.) 
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(This picture is only for reference.) 

 Note: With CAM connected, it is necessary to re-Initializing CI every time when turning on the 
application. 
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